
  Welcome to the first Full Circle of 2013!


  Indeed. Another year, another Full Circle! I believe that April this year will mark our sixth year. Wow! Anyway, back to the present. This month we have the usual Python, LibreOffice, Inkscape and Blender HowTo's. Joining them is an interesting HowTo on making your Ubuntu look Gnome 2 style (that's Gnome 2, not Gangnam).


  Former podcast host, Ed Hewitt, courts controversy this month on page 34 with his opinion of how the recently announced 'Ubuntu Phone' (as it's being nicknamed by the Internet) will inevitably fail. Have your say by giving your opinion in an article or in an email letter.


  I was gifted a Sony NSZ-GS7 Google TV box for Christmas. Read my review on page 37 of this issue. If you were gifted something techy for the holidays, please think about reviewing it. Remember, we're a magazine for the Ubuntu Linux community. Linux. This means you can review or write about any *buntu, Linux, or Android technology or distros.


  I've made a couple of small layout changes this month too. Don't panic, it's nothing major. Just a small tweak to sub-headings, drop caps and other behind the scenes font stuff. Non-cap sub-headings are so 2012...


  All the best, keep in touch!

  Ronnie

  ronnie@fullcirclemagazine.org


  Ubuntu News


  by Ubuntu Weekly News Team


  Ubuntu in 2013


  Mark Shuttleworth shares his thoughts about Ubuntu in 2013 with following: Its important to me, and to the wider Ubuntu community, the people be able to derive some benefit from our efforts. We know that there are plenty of smart people whos needs are well served by what existed in the past. We continue to maintain older versions of Ubuntu so that they can enjoy those tools on a stable platform. But we want to shape the future, which means exploring territory that is unfamiliar, uncertain and easy to criticise. Thats why Unity in 2013 will be all about mobile  bringing Ubuntu to phones and tablets.


  Read more at: http://www.markshuttleworth.com/archives/1221

  


  Its official: Ubuntu now fits phones


  Jane Silber CEO of Canonical announces that Ubuntu is coming to phone. Silber also announces new way of building apps for different form of factors i.e. QML based Ubuntu SDK and further work on Ubuntu for phones.


  Official announcement at: http://blog.canonical.com/2013/01/02/its-official-ubuntu-now-fits-phones/

  


  Ubuntu Phone


  The Ubuntu Phone is still trending in the news, particularly with the demos by Mark Shuttleworth, Jono Bacon, and the rest of the team from Canonical at the Consumer Electronics Show in Las Vegas this week!


  Check out this short video of Mark doing a demo or a longer one by Jono Bacon:


  
    	Ubuntu Phone OS Demonstration by Mark Shuttleworth at CES 2013 - http://www.youtube.com/watch?v=RO7QbCqFY7Y


    	( Ubuntu OS for SmartPhonesFeatures & Layout Demo & Hands-On Experience - https://www.youtube.com/watch?v=qE-QPsATAS0

  


  And now read on for more articles that caught our attention this week:



  
    	Ubuntu Smartphone Aims for Success in Developing Economies -

    http://www.technologyreview.com/news/509646/ubuntu-smartphone-aims-for-success-in-developing-economies/


    	Ubuntu On A Phone Or Firefox OS: Which Scares iPhone And Android Most? -

    http://www.techweekeurope.co.uk/comment/ubuntu-phone-firefox-os-linux-iphone-androi-103206


    	Top 5 reasons the Ubuntu Linux phone might make it - 

    http://www.zdnet.com/top-5-reasons-the-ubuntu-linux-phone-might-make-it-7000009721/


    	Mobile Linux Rivals Ubuntu And Sailfish Could Share AP -

    http://www.techweekeurope.co.uk/news/linux-ubuntu-sailfish-plasma-active-103978


    	Ubuntu Phone Download, Source Will Be Ready Late February - 

    http://www.omgubuntu.co.uk/2013/01/ubuntu-phone-download-will-be-ready-late-february


    	Canonical Shakes Up Mobile with Ubuntu for Phones -

    https://www.linux.com/news/embedded-mobile/mobile-linux/688686-canonical-shakes-up-mobile-with-ubuntu-for-phones


    	Ubuntu At CES -

    http://www.jonobacon.org/2013/01/13/ubuntu-at-ces/

  

  


  Welcome New Members and Developers


  Adam Stokes becomes a Ubuntu Contributing Developer - https://wiki.ubuntu.com/AdamStokes


  https://lists.ubuntu.com/archives/ubuntu-devel-announce/2013-January/001002.html

  


  Happy 300th Issue of UWN


  UWN has evolved to its current form with the help of many throughout the Ubuntu Community. The dedication, commitment, and passion the Ubuntu News Team has for ensuring that the community has a place to turn for a summary of each week of Ubuntu is amazing. Many thanks especially to Elizabeth Krumbach, Nathan Handler and others for automating much of a time consuming manual process. Thanks go out to the summary writers, reviewers and our social media guru Jasna Benčić. Thank you to everyone who supports UWN either by contributing or consuming! Here is to another 300 issues and to Ubuntu in all its many forms!


  Congratulations to the Ubuntu Weekly Newsletter team (past, present and future) for reaching the milestone 300th edition! UWN is a meaningful summary of the wide-ranging activities in the Ubuntu community and provides a valuable guide to the project, no matter what your level of involvement. I read it nearly every week on the wiki, skimming the table of contents and then jumping to the sections that catch my eye - usually that's the windows into the community such as LoCo News, Ubuntu Cloud News, and the Planet and blogosphere wrap up. UWN usefully and accurately captures the vast and fast-paced community activities in way that you can't find in other publications. Thanks to everyone who has contributed to UWN over the years - your support for Ubuntu and for the readers who rely on your work to understand what's happening in the Ubuntu community is legendary! ~ Jane Silber, Canonical CEO


  I read every section! The ones I pay the most attention to are the LoCo news, General community news and blogosphere and news articles. As a marketing team we pay attention to the Ubuntu articles in the press but I often find one that I hadn't seen. And, although I read planet, the LoCo news and community news is a great round-up of things that I wouldn't see without UWN. UWN is a fantastic resource because it shows the width and range of things that are happening in the Ubuntu world. Even though I'm probably more informed than most about what's happening in Ubuntu I always learn new things. I'm sure every reader is the same! I'd really like to thank everyone for taking part to create UWN - both the writers and the news contributors. You're really helping Ubuntu and Free Software by providing an easy way for anyone to get the latest news and happenings in the Ubuntu family. It's a great resource for finding out all the rich activity that's taking place every week in some part of the Ubuntu community. ~ Steve George, VP Operations, Canonical


  "Congratulations on your 300th issue! What an accomplishment. Thank you to the UWN news team for all of your hard work. It's collaboration and efforts like this that make the Ubuntu community so amazing. Keep up the great work and cheers to your continued success." ~ Leann Ogasawara, Ubuntu Kernel Team Manager, Canonical


  Congratulations to the Ubuntu News Team for pushing the Ubuntu Weekly Newsletter (UWN) to the 300th issue!!! UWN is a very good source for obtaining the newest information in the community of Ubuntu and Linux. If you want to see what the different teams are doing, or what sorts of new features are implemented, UWN is tailor-made for providing such news. I check into Ubuntu Weekly Newsletter every time I received it through Gmail, normally watching out the "Welcome new member and developers" (to congratulate the people who got a membership) and "The Planet" (where the newest features and team news can be found mainly). Thanks to everybody who contributed to UWN for this great newsletter, especially to Elizabeth Krumbach, Nathan Handler and other editors. Thank you UWN! ~ smartboy UWN Subscriber


  "I have helped on and off for several years with the publishing of the Ubuntu Weekly Newsletter. I also created several scripts to make the process easier and faster for everyone involved. Even with these scripts, preparing an issue of the newsletter still requires a significant amount of time each week from many volunteers. However, these volunteers understand the impact their work has on the greater Ubuntu community. Programmers, packagers, documentation writers, graphic artists, and general Ubuntu members all read and use the Ubuntu Weekly Newsletter to keep up-to-date on what is going on in the community. Everyone who has ever contributed to an issue of the newsletter should feel proud in knowing that they made an important contribution to Ubuntu. I look forward to reading and helping us reach issue 400." ~Nathan Handler, Ubuntu Member and UWN Editor


  "I've been working with the Ubuntu News team since 2010 and took up primary coordinator of issue releases in mid 2011. In this time I've worked with dozens of amazing people, including Nathan Handler who I worked with to make the release process much more streamlined with our amusing collection of Perl and Python scripts, Jasna Benčić who works hard to not only collect articles throughout the week, but also acts as summary writer, editor and social media guru, Amber Graner who has been happy to pitch in with releases on weeks when I'm traveling and Jim Connett and Matt Rudge who I've come to rely upon for editorial review each week. Finally, it's always a pleasure to meet and chat with our readers and the feedback I've received at random conferences and events I attend has been essential to improvements we've made over these past couple years. Thank you to everyone for making us what we are today and happy 300th issue!" ~ Elizabeth Krumbach, UWN Editor

  


  Vacant Developer Membership Board seats: Call for nominations


  Benjamin Drung, Stphane Graber, Iain Lane, and Cody Somerville will reach the end of their terms on the Developer Membership Board on 2013-02-13. Therefore Iain Lane puts out a call for nominations for new members, and explains the obligations of these nominees.


  https://lists.ubuntu.com/archives/ubuntu-devel-announce/2013-January/001004.html

  


  Application Review Board restaffing results


  Stephane Graber announces the results of the Application Review Board restaffing. Since a single nomination was filed, the nominee Jonathan Carters membership was confirmed bypassing the usual poll. However, the ARB is still understaffed by two members. Anyone interested in joining is directed to get in touch with ARB.


  https://lists.ubuntu.com/archives/ubuntu-devel/2013-January/036344.html

  


  Many Thanks to the Ubuntu News Team for their contribution this month.


  News this month comes from:



  
    	https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue298


    	https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue299


    	https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue300

  


  Google Music Review


  Lucas Westermann


  As many of you may already know, Google Music was recently rolled out to countries outside of the USA. As such, I finally had access to it in Germany, and promptly began uploading my music collection to the cloud.Due to the fact that I am not necessarily always on one of my own personal computers, and own multiple Android devices, having access to my music from anywhere was rather appealing. Nothing is worse for me than being stuck doing IT work at someone else's computer without music to listen to, especially if I can expect to be there for a long period of time.I've now been using Google Music for about 2 months, which meansits high time for an article!


  For anyone who is unsure what Google Music is, it is a free service offered by Google. It essentially allows you to upload 20,000 songs to your personal cloud, and allows you to stream your music from any web browser, synchronize the cloud with personal computers using the Music Manager application, and allowAndroiddevices full access to your cloud, from which you can pick and choose specific songs to keep locally on the device.


  The Setup


  Setting up your cloud is fairly easy.You start up the Music Manager application, select what you want to synchronize (and whether it is automatically synchronized or not), and then begin the process.The application seems to upload a maximum of two or three songs simultaneously, and for my roughly 2,000 songs, it took between 4 and 6 hours to upload (at an average upload speed of 50KB/s).As such, this may not be suitable for anyone with a slow upload rate.


  Managing


  The Google Play store now also offers music downloads, with a similar pricing scheme to the iTunes store or Amazon.In Germany, it seems that the selection isn't quite as completeas it could be, especially for more obscure artists. However, some MP3s are available for free, although there is no easy way to filter these out.Therefore, increasing the size of your music collection should be fairly easy!


  Managing your playlists and song information is just as simple as with any other music program.The nice thing is that if you edit any playlists that you have set as keep on device on any Androidsystems, they will automatically download the new files, which is a nice wireless solution.My music collection is thoroughly organized with album art and completed song information; thusI can't tell you if the cloud service automatically updates the information, or how easy it is to complete missing information.I would imagine it should be rather painless.Each song can be downloaded from the web page a maximum of 2 times, and an infinite number through the music manager, as far as I can tell.This is nice if you need quick access to an MP3 without going through any additional setup.


  As far as I can tell, you need to configure your computer for uploads before being able to automatically synchronize new files.I haven't yet configured uploads on my laptop, making it difficult to tell for certain.I remember initiating the process and having the laptop begin uploading the MP3s as normal, although no duplicates appeared in my cloud database.This probably means that Google sorts out duplicatesafterthey've been uploaded  so keep in mind that you are effectively uploading your library twice for no particular reason.I could be wrong, but it certainly seems that way. If anyone has different experiences, let me know via email.


  Quality


  The uploaded files are converted to 320 kbps MP3 if they are in an unsupported format such as FLAC or OGG.Otherwise they seem to retain their file types (my MP3s are all highest-quality variable bit-rate for my mobile devices). Streaming on a mobile network results in a lower quality, in order to save your bandwidth/handle the lower speeds of a mobile network.When using a wireless network, the quality of audio is akin to playing the local file on any of my devices.However, initiating the queue can occasionally take a couple of seconds before it's buffered.Once playback has started, it seems there are no pauses between songs (with the exception of whenthere are massive drops in bandwidth/available speeds).


  Playback


  Playing back music directly from your cloud storage is possible only through a web browser on non-mobile devices (laptops, PCs, etc).If you have a mobile device that runs Android, accessing and playing the music directly from the cloud is possible with the Google Music app.This does not appear to be the case with any non-Androidoperating systems. There is also no support for media keys, or playback information in Conky. There is, however, an extension for Chrome called Music Plus (developed by the editor-in-chief of Lifehacker), that offers further features, such as a popup controller, last.fm scrobbling, html5 notifications, etc. For a link, check the further reading section.


  Google Music does offer the ability to create playlists based on a song, including both music you own and music that is available on the music store.Not all MP3s seem to stream in full length when doing this, but it's an excellent option for finding new music.


  Conclusion


  This is a very useful free service to use if you listen to your music often on mobile devices (such as a phone or tablet), where you may not want to have local copies of every song taking up space.It's also a wonderful solution for anyone who has issues syncing music with an Androiddevice, as it effectively avoids the issue of compatibility.If you own a laptop with limited space, you may also very much appreciate this system, although there are a few restrictions when using Google Music purely in the cloud.Lastly, if you have massive amounts of music, or a slow internet connection, this is probably not for you.It could definitely fulfill the role of a cloud backup for music purchases, or for backing up certain favorite songs, as you have a lot of control over what files are ultimately uploaded.


  Due to the playback restrictions, I don't see Google Music replacing a local music player any time soon, but it definitely makes life a bit easier when organizing your music across multiple devices.If you're someone like me who is constantly on the hunt for more music to listen to, you may also like some of the more advanced features offered by Google.


  Further Reading


  
    	https://chrome.google.com/webstore/detail/ipfnecmlncaiipncipkgijboddcdmego Music Plus


    	http://music.google.com Google Music website

  


  Programming in Python - Part 40


  By G.D. Walters


  Last time, we had a gross discussion about the TVRAGE web API. Now we will start to look at writing code to work with it.


  The goal of this part is to begin the process of creating code that will be a reusable module that can be imported into any python program and will provide access to the API easily.


  
    	Search for show by show name, and get the ShowID


    	Get show information based on ShowID


    	Get episode specific information based on ShowID


  


  Last time, I showed you the unregistered and accessible-by-anyone API calls. This time we will use the registered calls  based on a registration key I have. Im going to share this key with you (TVRAGE knows that Im going to do this). However, I ask that, if you are going to use the API, that you please register and get your own key, and that you dont abuse the site. Please also consider donating to them to support their continuing efforts.


  We will create three main routines to make the calls and return the information, three routines that will be used to display the returned information (assuming that we are running in the stand alone mode), and a main routine to do the work  again assuming that we are running in the stand alone mode.


  Here is the list of routines we will be creating (although not all of them this time. I want to leave room for others in this issue.)


  
    def FindIdByName(self, showname, debug = 0)

    def GetShowInfo(self, showid, debug = 0)

    def GetEpisodeList(self, showid, debug = 0)

    def DisplaySearchResult(self, ShowListDict)

    def DisplayShowInfo(self, dict)

    def DisplayEpisodeList(self, SeriesName, SeasonCount,

    EpisodeList)

    def main()
  


  The routine FindIdByName takes a string (showname), makes the API call, parses the XML response, and returns a list of shows that match with the information in a dictionary, so this will be a list of dictionaries. GetShowInfo takes the showid from the above routine and returns a dictionary of information about the series. GetEpisodeList also uses the showid from the above routine and returns a list of dictionaries containing information for each episode.


  We will use a series of strings to hold the key and the base URL, and then append to those what we need. For example consider the following code (well expand these later).


  
      self.ApiKey = "Itnl8IyY1hsR9n0IP6zI"  self.FindSeriesString = "http://services.tvrage.com/myfeeds/search.php?key="
  


  The call we need to send (to get back a list of series information with the series id) would be:


  
    http://services.tvrage.com/myfeeds/search.php?key=Itnl8IyY1hsR9n0IP6zI&show={ShowName}
  


  We combine the string like this...


  
    strng = self.FindSeriesString + self.ApiKey + "&show=" + showname
  


  For the purposes of testing, I will be using a show named Continuum which, if youve never seen it, is a wonderful science fiction show on the Showcase network out of Canada. Im using this show for a few reasons. First, there are only (as of this writing) two shows that match the search string Continuum, so that makes your debug easy, and secondly, theres currently only one season of 10 episodes for you to deal with.


  You should have an idea what you will be looking for in your parsing routines, so Ive placed the full URL calls below for you to test, before you get started with your coding.


  Search using a show name...

  http://services.tvrage.com/myfeeds/search.php?key=Itnl8IyY1hsR9n0IP6zI&show=continuum



  Retrieve Series information using the ShowID (sid)

  http://services.tvrage.com/myfeeds/showinfo.php?key=Itnl8IyY1hsR9n0IP6zI&sid=30789


  Retrieve Episode list and information using the ShowID (sid)

  http://services.tvrage.com/myfeeds/episode_list.php?key=Itnl8IyY1hsR9n0IP6zI&sid=30789


  Now that we have all that out of the way, lets get started with our code.


  Youll create a file with the name of tvrage.py. Well be using this for the next issue or two.


  Well start with our imports...


  
    #=============================================================

    #          IMPORTS

    #=============================================================

    from xml.etree import ElementTree as ET

    import urllib

    import sys

  


  You can see that we will be using ElementTree to do the XML parsing, and urllib for the internet communication. The sys library is used for sys.exit.


  Well set up the main loop now so we can test things as we go. Remember this is the last thing in our source file.


  
    #===========================================================

    #  Main loop

    #===========================================================

    if __name__ == "__main__":

    main()

  


  Now we start our class. The name of the class is TvRage. Well also make our __init__ routine now.


  
    class TvRage:

      def __init__(self):

        self.ApiKey = "Itnl8IyY1hsR9n0IP6zI"

        self.FindSeriesString = "http://services.tvrage.com/myfeeds/search.php?key="

        self.GetShowInfoString = "http://services.tvrage.com/myfeeds/showinfo.php?key="

        self.GetEpisodeListString = "http://services.tvrage.com/myfeeds/episode_list.php?key="

        self.ShowList = []

        self.ShowInfo = []

        self.EpisodeList = []

        self.EpisodeItem = []

  


  As I said earlier, the first four lines are our partial strings to build the URL for the function that we want to use. (GetEpisodeListString should all be on one line.) The last four lines are the initialization of the lists we will be using later.


  
      def FindIdByName(self,showname,debug = 0):

        strng = self.FindSeriesString + self.ApiKey + "&show=" + showname

        urllib.socket.setdefaulttimeout(8)

        usock = urllib.urlopen(strng)

        tree = ET.parse(usock).getroot()

        usock.close()

        foundcounter = 0

        self.showlist = []

  


  First, we set up the string that will be used as the URL. Next, we set up the socket with an 8 second default timeout. Then we call urllib.urlopen with our generated URL and (hopefully) receive our xml file in the usock object. We call ElementTree setup so we can parse the xml information. (If you are lost here, please re-read my articles on XML (parts 10, 11 and 12 appearing in FCM #36, 37 and 38)). Next, we close the socket, and initialize the counter for the number of matches found, and reset the list showlist to an empty list.


  Now we will step through the xml information using the tag show as the parent for what we want. Remember the returned information looks something like this:


  
    <Results>

      <show>

        <showid>30789</showid>

        <name>Continuum</name>

        <link>http://www.tvrage.com/Continuum</link>

        <country>CA</country>

        <started>2012</started>

        <ended>0</ended>

        <seasons>2</seasons>

        <status>Returning Series</status>

        <classification>Scripted</classification>

        <genres>

          <genre>Action</genre>

          <genre>Crime</genre>

          <genre>Drama</genre>

          <genre>Sci-Fi</genre>

        </genres>

      </show>

      ...

    </Results>

  


  We will be going through each group of information for the parent show and parsing out the information. In practice, all we really need is the show name (<name>) and the showid (<showid>), but well handle all of the results.


  
        for node in tree.findall('show'):

          showinfo = []

          genrestring = None

          dict = {}

          for n in node:

            if n.tag == 'showid':

              showid = n.text

              dict['ID'] = showid

  


  Ill discuss the first one and youll understand the rest. As we go through the information, we look for tags that match what we want. If we find any, we assign each to a temporary variable and then put that into the dictionary as a value with a key that matches what we are putting in. In the case of the above, we are looking for the tag showid in the XML data. When we find it, we assign that as a value to the dictionary key ID.


  
           elif n.tag == 'name':

              showname = n.text

              dict['Name'] = showname

            elif n.tag == 'link':

              showlink = n.text

              dict['Link'] = showlink

            elif n.tag == 'country':

              showcountry = n.text

              dict['Country'] = showcountry

            elif n.tag == 'started':

              showstarted = n.text

              dict['Started'] = showstarted

            elif n.tag == 'ended':

              showended = n.text

              dict['Ended'] = showended

            elif n.tag == 'seasons':

              showseasons = n.text

              dict['Seasons'] = showseasons

            elif n.tag == 'status':

              showstatus = n.text

              dict['Status'] = showstatus

            elif n.tag == 'classification':

              showclassification = n.text

              dict['Classification'] = showclassification

  


  The next portion deals with the genre(s) of the show. As you can see from the above XML snippet, this show has four different genres that it fits into. Action, Crime, Drama, and Sci-Fi. We need to handle each.


  
            elif n.tag == 'genres':

              for subelement in n:

                if subelement.tag == 'genre':

                  if subelement.text != None:

                    if genrestring == None:

                      genrestring = subelement.text

                    else:

                      genrestring += " | " + subelement.text

              dict['Genres'] = genrestring

  


  Finally, we increment the foundcounter variable, and append this dictionary into the list showlist. Then we start the entire thing over until there is no more XML data. Once everything is done, we return the list of dictionaries.


  
          foundcounter += 1

          self.showlist.append(dict)

        return self.showlist

    #========================================================

  


  The next thing we will do is create the routine to display all of our results.


  
        def DisplayShowResult(self, ShowListDict):

         lcnt = len(ShowListDict)

          print "%d Found" % lcnt

          print "------------------------"

          cntr = 1

          for c in ShowListDict:

            print "%d - %s - %s" % (cntr,c['Name'],c['ID'])

            cntr += 1

          sel = raw_input("Enter Selection or 0 to exit -> ")

          return sel

  


  Most of the code is pretty self explanatory. Well concentrate on the for loop we use to print out the information. We loop through each item in the list of dictionaries and print a counter variable, the show name (c[Name]), and the id. The result looks something like this...


  
    Enter Series Name -> continuum

    2 Found

    ------------------------

    1 - Continuum - 30789

    2 - Continuum (Web series) - 32083

    Enter Selection or 0 to exit ->

  


  Please remember that the list of items is zero based, so when the user enters 1, they are really asking for dictionary number 0. We do this, because regular people think that counting should start with 1 not 0. And we can then use 0 to escape the routine and not make them use Q or q or -1.


  Now, the main routine that pulls it all together for us.


  For today, well just start the routine and continue it next time.


  
    def main():

      tr = TvRage()

      #--------------------

      # Find Series by name

      #--------------------

      nam = raw_input("Enter Series Name -> ")

      if nam != None:

        sl = tr.FindIdByName(nam)

        which = tr.DisplayShowResult(sl)

        if which == 0:

          sys.exit()

        else:

          option = int(which)-1

          id = sl[option]['ID']

          print "ShowID selected was %s" % id

  


  Next time, well add the other routines. For now, the code can be found at http://pastebin.com/6iw5NQrW


  See you soon.

  


  
    BIO: Greg Walters is owner of RainyDay Solutions, LLC, a consulting company in Aurora, Colorado, and has been programming since 1972. He enjoys cooking, hiking, music, and spending time with his family. His website iswww.thedesignatedgeek.net.
  


  LibreOffice Part 22: Base Queries and Reports


  If you have been following along in this series on LibreOffice Base, you now have a database file with tables and relationships. You can enter information into your database through forms, but what about getting information out of the database? Queries and Reports are used for extracting data from your database - the Queries define what data is extracted, and the Reports define the appearance of the extracted data. We will create a query and a report to show how you can generate a report of your data.


  Creating a Query


  [image: ]


  Queries poll the database for certain information in your database. You have three ways to create a query: a wizard, design view, and SQL. The wizard doesn't work with the type of relational database we have created and SQL is beyond the scope of this How-to, so we will use the design view to create our query. We will create a query that contains all the important fields in our tables: title, published year, author(s), and type(s).


  Click on Queries in the Database pane, then click on Create Query in Design View in the Tasks pane. A Query design form will display with a Add Tables or Query pop-up dialog. Add all the tables to the Query Design form, and close the pop-up. You will end up with a form that looks a lot like the relationships design we created previously. Below the tables, you see a form that will contain the fieldswhich we want to include in our query. From the Books table drag Title and Published into the form. Drag Name from Authors, and drag Type from Media. That is all we need for this query. Save it as AllFields. Close the Query Design form.


  You now have a query to use in creating multiple reports for your database. If you're curious about the SQL used to create your query, you can right-click on the newly created query and select Edit in SQL View. This brings up the SQL View with the complete SQL statement for the query you just created. I wouldn't recommend changing this unless you are well versed in SQL, but creating multiple queries in Design View, and then viewing them in SQL View, could help you begin to learn SQL.


  Creating A Report


  A report runs a query and formats the query results into something you can use. You can create many different reports with the query we created  depending on how you group the data from the query. We will create a report for sorting our books by media type, and I will suggest how you might create other reports using the same query.


  There is only one way to create a report use the wizard. Select Reports in the Database pane and click on Use Wizard to Create Report. A report template window will appear with the report wizard. You can actually watch your template fill in as you go through the steps of the wizard, giving you some ideas about how your final report will look.


  [image: ]


  In step 1, you will pick your query and the fields to use in the report. If not selected already, select the AllFields query we just created. Move all the fields into the Fields in report box by clicking on the >> button. If you wanted to create a report that uses just some of the fields, you would just select the required fields.For our report, we will use all the fields. Click Next.
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  Step 2 is labeling our fields. Here we specify how the fields are labeled in our report. Changed the label for Type to Media Type, and Name to Author(s). Click Next.
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  We create our groupings in step 3. Groupings control how the fields are consolidated and arranged in the report. Grouping is important, because we can use it to create a whole different report depending on how we group the fields. For example, if you wanted to create a report of titles by author, you would make Name your first grouping, then Title as a sub-group. For our report, we are creating a report of Titles by Media Type, so our grouping order is Type, Title, Published. We add published because, if there is more than one author, the published date will repeat in the report template, a byproduct we don't want. We exclude the Name field because if there is more than one author, we want them listed together. Click Next.
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  Sorting is done in step 4, but we don't have much use for it here. You will notice that you can change only whether the sorting is ascending or descending for our groupings. In the fourth box, select Name and leave on Ascending. Click Next.
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  In step 5, we can choose a layout for the data and the header. There are several for each, and they change the look of the report. I left mine at the defaults, but feel free to play around with these options. Under the Layout of data list box, you can select whether the report is landscape or portrait. For this report, I think portrait will work best. Click Next.
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  The final step is where we create the report. You can give it a title, indicate how the report is used, and what to do with the report. For this report, give it a title of TitleByType. Now, we need to answer the two questions. What type of report do you want to create? A static report is a one time report. It cannot change. Once it is created, the data is fixed. If, however, you want a report you can re-use, you want a dynamic report. A dynamic report is just a template you can use over again. For this report, we want a dynamic report we can use again, so select Dynamic. How do you want to proceed after creating report? Modify report layout will allow you to edit the report as a writer document. Create report now is obvious;it will fill in the data and generate the report. We can always edit the layout later, so we will select Create report now. Click Finish.


  Base generates our report and displays it in a Writer window. This generated report is read-only. If you want to edit the text or layout of the report, close it. In the Reports pane, right-click your report and edit. This opens the report template in Writer, where you can add text, graphics, etc,just like you would in any Writer document. Just take care when changing anything in the cells where the data is plugged in.


  In this How-to, we created a query and a report. Play around with the grouping and sorting settings in the report wizard and see just how many different reports you can create from the one query we created.


  Next time, we will use macros to create enhancements to our database and make it act more like an application.


  Ubuntu 12.04 - Gnome 2 Style


  by Marcel le Roux


  I, like many fellow ex-Ubuntu fans, moved over to Linux Mint to get as far away from the Unity desktop as possible. Although I was initially impressed with Mint, my concern has beenthat there are just too many desktop variations. Seeing that Mint is based on Ubuntu anyway, I decided to take another look at this distro with the release of 12.04 LTS. However, I had no intention of settling on Unity, so quickly researched ways in which to install Gnome 3 and tweak it to look and work like the much loved Gnome 2. I won't take any credit for the workarounds I found and managed to cobble together to achieve my goal. Seeing that it worked for me, I just wanted to share it with everyone else. So, here goes:


  After installing Ubuntu 12.04, boot your computer and install Gnome 3. Copy andpaste the following lines for the latest release from the Gnome team into a terminal (type Ctrl-Alt T to open a terminal window):


  
    sudo add-apt-repository ppa:gnome3-team/gnome3

    sudo apt-get update

    sudo apt-get install gnome-shell
  


  Reboot your computer, and when you are prompted with your login screen, click on the little Ubuntu icon next to your login name and choose Gnome Classic.
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  Moving The Windows Buttons (maximize, minimize and close) back to the right: Open up a terminal again and copy in the following:


  
    gconftool -s /apps/metacity/general/button_layout -t string menu:minimize,maximize,close
  


  You may want to also consider installing the Gnome Tweak Tool which will give you greater control over your shell extensions and several other Gnome settings. You can install this tool directly from the Ubuntu Software Repository, or by copy-pasting the following line into a terminal:


  
    sudo apt-get install gnome-tweak-tool
  


  You can now find this tweak tool by searching for Advanced Settings in your applications or in System Tools menu.
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  If you want to change themes, get rid of the overlay scrollbars, and make many more tweaks, you can download and install this handy tool as well: http://ubuntu-tweak.com. Once installed, you can find Ubuntu Tweak under the Ubuntu System Settings menu.
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  Finally, and this is only my personal preference, you can remove the top panel by pressing alt + right-click and selecting "Remove Panel". You can then add the main/start menu, notification area, indicator applet, etc,to the bottom panel by pressing alt + right-click and selecting "Add to Panel". I am very happy with the end result, and, so far, it seems to be very stable.
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  Blender Part 2


  by Nicholas Kopakakis


  As I promised last month, today we are going to create something. But first let’s destroy a cube!


  Start a new project in Blender:File-> New, or just open Blender.


  Press Numpad-1 to have a front view. At the upper-left corner you can check what you are viewing.


  Now press Numpad-5. You change your view from Perspective to Orthographic. Pressing Numpad-5 toggles the view from perspective to orthographic and vice-versa.


  
    TIP:Perspective view is the way our eyes see the world. Objects that are closer seem bigger than objects that are further.
  


  Orthographic view, onthe other hand, is like seeingan object from an infinite distance. All objectsseem as they are at the same distance relativeto the eye. Orthographic projection is a means of representing a three-dimensional object in twodimensions

  (http://en.wikipedia.org/wiki/Orthographic_projection), very useful for modeling!


  [image: ][image: ]


  On the leftimage, we have an orthographic view. Our brain cannot understand which side is the front. But it is great for creating models, as we don't actually care for one perspective but for the actual dimensions of our model. The perspective is going to be more realistic if we create models ignoring the perspective!


  In the rightimage, we see the cube from perspective view, so our brain can understand which side in nearer, knowing that is a cube.


  Of course, this is my opinion. Maybe you can model better and faster using perspective view. It's up to you.


  A few months ago, Mark started to demonstrate the great program Inkscape (we will see in the future how we can use Inkscape with Blender) creating a snowman. I really liked his example, so let’s create a snowman as well. But first, destroy the cube!


  Select the cube with the RMB (Right Mouse Button) and press the X key or Delete key and confirm the destruction by pressing Enter.


  Now press Shift+A to add something, and, from the menu, click Mesh->UV Sphere or, from the header, press Add->Mesh->UV Sphere to add a new mesh to your scene. A sphere appears.


  I guess that you are in front-orthographic-view (check the top left corner on your 3d view window) with the sphere selected. If not press Numpad-1.


  Press Shift+A to add a new mesh. A UV sphere again. You don't see any difference in your monitor. Don't worry. LMB and hold the blue arrow pointing upwards, to move the sphere up on the Z-axis. Place it near the top of the revealing sphere.


  Press S to scale down the sphere moving your mouse to the center of the cursor. Move your sphere down again to be a little “in” the big sphere.


  Now press Shift+D key to duplicate the selected sphere. Press Z to lock the movement to Z-axis, and press and hold LMB to move it up near the top of the second sphere.


  Press S and scale down the third sphere.


  Ok, we have something.


  Press File->Save As to save your work so far. Select where you want to save your file, give it a unique name (snowman.blend for example), and press the Save As Blender File button on the upper right corner. Great!


  Now, select the first sphere by pressing the RMB on it. Press S and then Z to scale down your sphere altering only the Z-axis.


  Do the same for the other two spheres to make them look more “real”. The gravity pulls the snowballs to the ground.
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  Press N to open or close the properties window on the right of your 3D view.There, you can inspect and alter your object's properties by actual numbers.
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  On the Front Ortho view, press LMB somewhere right of the snowman body. Press Shift+A to add Mesh->Cone. Press R for rotation, and 90 for the rotation degrees.


  
    TIP:You can manually input values by pressing directly a value. Your cone rotated 90 degrees clockwise. You can also use negative values for rotating your object counter-clockwise.
  


  Press Numpad-3 for the right view. Press S for scale and Shift+X to constrain the X value and alter the Y and Z values together. Scale the cone down to look more like a carrot-size nose relativeto the third-created (snowman head) sphere.


  OK, press Numpad-1 for front view, and press S and X to alter the X value alone. Now create a long or a short carrot-nose.


  Press R and -10 to rotate the nose 10 degrees counter-clockwise.


  Using the front view and the right view, place the nose somewhere in the middle of the snowman's head.


  Now let’s create some buttons. Press Shift+A to add a Mesh->Cylinder. Use thesame tools to create a little coin-like button as the ones we use to create the carrot-nose. Scale it, rotate it, use your imagination! Don't forget to duplicate with Shift+D to be more productive.


  When you are happy with your model, save your work.


  Press F12 to render.


  Your snowman seems a little bit silly. The snow doesn't have this kind of edges like well crafted crystals! We have to smooth that up.


  So, press T key to bring up the toolkit on the left. Under the Shading section, you have two options: Smooth and Flat. With one sphere selected (or all) press the Smooth button. Your snowman is smoother now!
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  You can see the differences. On the right, the spheres are flat with a more crystal like cut, and on the left,we have applied the smooth shader giving a more smooth and natural feel of snow.


  Using the box selection tool that we mentioned last month, select all objects that, united, represent “the snowman”. The spheres, the cylinders, and the cone.


  Using the blue arrow, move the snowman up as shown in the images above, a little bit down the red axis.


  Press Shift+S. From the Snap menu that appeared, select Cursor to Center. Press numpad-7 for the top view. Press Shift+A to add a new mesh. A plane. Press S for scaling the plane and 10 to scale it up 10 times.


  We have a ground.


  Save your work under a unique name.


  Render your snowman by pressing F12.


  If your camera doesn't capture your model as you like, move your camera.
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  Every month, I'll suggest an interesting site for Blender. For this month, I highly recommendhttp://www.Blendernation.com. A very useful site with hot news about Blender.


  Also for this month I have a video for you. Go tohttp://www.youtube.com/watch?v=TLkA0RELQ1g, and enjoy “elephants dream”a short film created with Blenderin 2006, by orange open movie project.


  Next month, we will add a hat, maybe a pipe, and his brush-like hands. Also, I will introduce you to the edit mode – the place where you are going to spend most of your Blendertime!!

  


  
    BIO: Nicholas lives and works in Greece. He hasworked for a post-production house (commercials - films) for several years. Some months ago, he migrated to Ubuntu because “it renders faster”. Blender found him two years ago.
  


  Drawing with Inkscape  Part 9


  By Mark Crutch


  Having covered the use of groups in Inkscape, we're now going to move onto 'layers'  which are just like groups, but with a different interface for manipulating them. There's a good reason for the similarities between groups and layers: the SVG format has no concept of layers, so Inkscape actually implements each layer as a group with some extra bits of custom data.


  There are three parts of the Inkscape interface that are used for managing layers: the Layer menu, a dedicated Layers dialog, and some quick access tools in the status bar at the bottom of the screen. Let's start with the Layers dialog which can be opened via the Layer > Layers... menu entry, by pressing CTRL-SHIFT-L, or by using the View Layers button on the toolbox:[image: ]
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  The layers dialog is fairly sparse, consisting of a list of layers at the top, and a few buttons and other widgets at the bottom. For a new file, only a single layer will be present, usually named Layer 1. Create a few objects in your drawing, and they will become part of that layer. Now try clicking on the little eye icon to the left of Layer 1, and you'll notice that your objects vanish. Click it again and they reappear. Click on the lock icon and you'll be prevented from making any changes to the objects in your layer. A second click will unlock the layer.


  There are several ways to create a new layer, but the most obvious is simply to click the green + button at the bottom of the Layers dialog. You'll be prompted to give the layer a name, and pick a position for it. For now, let's call our new layer Layer 2 and position it above the current layer.
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  The Layers dialog should appear much as you would expect, with two entries: Layer 2 is at the top of the list and Layer 1 is below it. The order of layers in the dialog represents their z-index within the drawing such that layers lower in the list will appear behind layers that are higher in the list. Check that Layer 2 is selected and draw some more objects, ensuring that they overlap the previous objects from Layer 1 and are in a suitably contrasting color. You should be able to see that your new objects are always drawn on top of the old objects. Using the arrow icons at the bottom of the Layers dialog, you can re-order your layers, which in turn alters the z-index of the objects in your drawing. You may recall that the contents of groups can't be interleaved, with each group occupying a single slot in the z-index. The same applies to layers: you can move them relative to one another, but their contents can't mix.


  When creating a new layer you can use the Position pop-up to choose whether the new layer should be above or below the current layer. There is also a third option, which is to make it a sublayer of the current layer. Sublayers appear below their parent layer in the dialog, slightly indented. The parent gains a small triangle icon that can be used to show or hide the list of sublayers. In the same way that groups can be nested down to deep levels, so it's possible to add sublayers to sublayers  although going more than two or three levels deep is likely to confuse more than it helps. This image shows our Layer 1 with the addition of three sublayers, two of which also have sublayers of their own, one of which is collapsed using the triangle button:
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  The order of sublayers within the dialog follows the same rules as for normal layers: the lower down the dialog a sublayer is, the lower down the z-index its contents will be in the drawing. From this, it follows that a sublayer's content will always appearbelowany content in its parent layer. Although this makes logical sense, it's often not what you want artistically, so I find that the best approach to using sublayers is simply to keep the parent layer empty of objects and construct an additional sublayer below the others to hold any background content.


  The biggest advantage of sublayers is as a means to quickly hide several parts of an image at once. Considering our snowman from previous instalments, you could easily construct a parent layer to contain the snowman as a whole, with several sub-layers for each part of his body. Now you have the ability to hide or lock individual parts of him by using the icons next to each sublayer, or to quickly hide or lock the whole character using the icons by the parent layer.
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  You may recall that the previous instalment suggested grouping the various parts of the snowman together to create a single object that you can easily move around. So which is better, grouping or layers? As is so often the case, the answer is it depends. For something like the snowman I would tend to use groups: the ability to move the whole character as one is usually more useful than the ability to easily hide it. For the background of the image  the snow, sky and stars  I would probably use a layer: you're unlikely to move the background much, but you may want to hide it when working on the snowman, or lock it to prevent it accidentally being modified once you're happy with it.


  Let's look at a real-world example. This is a comic strip I drew in 2010, together with the corresponding Layers dialog. You can download the Inkscape source file from the URL at the end of the article:
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  Working from the top layer downwards, we first have a Frame layer which is locked. This is a thick black border that sits as the topmost layer in most of my comics and hides the ends of lines that extend outside the main image, meaning that I don't have to be quite so careful when drawing objects near the edge of the scene. Next is the text layer, which holds both the caption for this comic, and the box it sits in. That layer is also locked to prevent me accidentally moving it when editing other parts of the comic.


  Below that is the Content layer. In many of my comics this is used as a normal layer in its own right, with all the main characters and props being placed directly into it. In this case, I wanted to be able to hide various parts of the drawing as I was working on it, so the Content layer is just a holder for various sub-layers. Inside each of those sub-layers the objects are grouped, such that the Towers layer contains three groups, one for each layer. That allowed me to move each tower individually, whilst still giving me the option to hide them all at once.


  The Background layer holds everything else that's visible within the comic image, including the arena walls and hilly horizon. The Border layer, locked once again, holds a common border that I use with my comics which contains license information, the URL of my website and a drop shadow.


  Those last two layers are particularly interesting because they both contain heavily blurred objects. Blurs are implemented as SVG filters, which will be covered in a future article, but at this stage it's useful to know that filters can be mathematically intensive, and can significantly slow Inkscape's redraw speed. One of the best ways to avoid this slowdown is to hide the layer that contains the filtered objects. Inkscape doesn't have to draw them, so it doesn't do the mathematical operations required, and it can render your image much more quickly.


  When drawing a complex image, you may find that you need to move objects between layers. This can't be done from the layers dialog, but is instead handled from the Layer menu or a keyboard shortcut. Select the objects you want to move, and use Layer > Move Selection to Layer Above (SHIFT+PageUp) or Layer > Move Selection to Layer Below (SHIFT+PageDown).


  Another option you'll see in the Layer menu is Duplicate Current Layer. This not only duplicates the layer itself, but also all the objects within that layer, including any sub-layers and their contents. Because the duplicated objects appear directly on top of the originals, it's not always obvious that copies have been created, so be a little careful when using this option. You can also duplicate layers directly inside the Layers dialog by using the context menu on the layer name. Although the context menu offers up a Rename Layer... option, it's usually easier to just click on a selected layer name which turns it into an editable field.


  One odd omission from the context menu is the option for deleting a layer. This is available via the Layer > Delete Current Layer menu entry, or by the red minus button in the dialog. Be aware that this will delete the layer and everything within it, including sub-layers, without any further prompting. If you do inadvertently delete a layer then all is not lost, as Edit > Undo (CTRL-Z) will restore it.


  Let's finish our tour of the Layers dialog with the controls at the bottom. The Opacity slider works in the same manner as the one in the Fill and Stroke dialog, but applies to all the objects in the selected layer. It's yet another of Inkscape's many ways of making objects invisible.


  The Blend Mode pop-up defines how the selected layer is drawn with respect to the layers below it. Much like the Blur slider in the Fill and Stroke dialog, it's actually a shortcut for adding a filter. The blend modes on offer are Normal, Multiply, Screen, Darken, and Lighten  although there's rarely much reason to use anything other than Normal. I know of one artist who puts all the shadows in his images into a single layer which is set to Multiply, and I've also used the Multiple mode to produce an anaglyph 3D image of the space shuttle. In this image I've used that anaglyph space shuttle to demonstrate the differences between the blend modes, but the actual effect produced is highly dependent on the colours you start out with.
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  There's one aspect of layer management left to mention: the pop-up menu on the status bar. This allows you to quickly switch between layers and to hide, show, lock, or unlock the current layer using the buttons to the left of the pop-up.
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  The previous instalment introduced this pop-up in the context of managing groups. This is a side-effect of the fact that layers are just groups with a bit of extra metadata. In this case, the name in the button will actually be the internal ID of the group, and you can use the menu to exit a group by switching to a parent group, or straight to a different layer entirely. This can be particularly useful if you're in a deeply nested collection of groups as it provides a mechanism to jump back through several steps at once.
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  Beware, however, that using the Hide or Lock buttons when you've got a group selected can be dangerous, resulting in hidden groups that you can't easily reveal or locked groups that you can't readily unlock. For this reason I tend to only use the Hide and Lock buttons in the Layers dialog, or at least double-check that I'm not inside a group before using them from the status bar.


  Links:


  The comics used in this tutorial, plus their Inkscape source files, can be downloaded from: http://www.peppertop.com/fc/

  


  
    Markhas been using Linux since 1994, and uses Inkscape to create two webcomics, 'The Greys' and 'Monsters, Inked' which can both be found at:

    http://www.peppertop.com/
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  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.


  Write your article in whichever software you choose—I would recommend LibreOffice. But, please spell and grammar-check it!


  The Official Full Circle Style Guidecan be read at:http://url.fullcirclemagazine.org/75d471


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.


  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!


  FOR REVIEWS:


  Games/Applications


  When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary – with positive and negative points


  


  Hardware


  When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary– with positive and negative points


  


  You don't need to be an expert to write an article– write about the games, applications and hardware that you use every day.


  Ask the New Guy


  by Copil Yáňez


  Hi, everyone! Welcome back to Ask the New Guy!


  If you have a simple question and want an answer that doesn’t require intimate knowledge of who Linus Torvalds is angry at this week, contact me at copil.yanez@gmail.com.


  Today’s question is:


  
    I keep hearing about “the cloud.” What is The Cloud? Is it dangerous? What does it smell like?
  


  In talking about The Cloud, I like to give the same sage advice my dad always gave me when he encountered a strange cloud in the house: He who smelt it, dealt it.


  The advice isn’t actually too far off. The Cloud can mean different things to different people, and its purpose and function are closely associated with he or she who “smelt it,” meaning, the company or program that offers cloud services determines how it will work in practice.


  When we talk about The Cloud, we’re talking about offloading computing or storage duties to someone else’s machine. Everything from gaming, to listening to music, to storing family pictures, can be done in The Cloud.


  But wait, you say. I’ve spent countless hours accumulating pictures of my My Little Pony collection. Why would I let someone else store them for me? Unless he, too, was a bronie?


  Here are just a few advantages to doing things in the cloud:


  


  
    	Your data is backed up: In the event of a catastrophic Four Loko spill on your laptop at a LAN party, all those funny sloth jpgs are safe and sound.


    	Your data is safe: Even if you’re careful to back up your files to an external hard drive and print out all your emails on a weekly basis and store them in a fireproof safe like I do, you’re still not likely to have your data replicated across as many servers as the typical cloud storage service like Ubuntu One, Dropbox, or Google Drive.


    	Your data is accessible anywhere: You’re totally hitting it off with a cute guy you just met at your local LARP Con and want to show him your Galadriel cosplay. Just bring up your cloud service app on your smartphone, show him the pictures and, boom, you’re dating that Aragorn lookalike!


    	Your data is private: You are the only one with access to the Jersey Shore style book you created for yourself.

  


  Sounds good, right?


  Well, there are some downsides.


  
    	Your data is NOT backed up: Sure, your preferred service is storing a scanned copy of your birth certificate so you send the original to your parents for safe keeping. But your cloud service just went down for maintenance and you’re being inaugurated as the next President of the United States in TWENTY MINUTES! Your data may be backed up, but what does that mean if you can’t access the backup? This is bad. Just ask Barack Obama.


    	Your data is NOT safe: Replication on the other end is great! Until every one of their servers are subpoenaed by the Department of Justice. This exact thing happened to cloud storage service Megaupload.com. There’s a remote possibility those users will get their stuff back from the US government. But you’re more likely to get a full body rubdown by the TSA, so I wouldn’t hold my breath.


    	Your data is NOT accessible anywhere: Oh look, you got a new tablet! Cool. Yeah, our service doesn’t roll out for that device for another thirty days. Sorry. Now you’re stuck dating the guy who looks like Bilbo.


    	Your data is NOT private: No one but you has access to your files. Except the government. And disgruntled ex-employees. And hackers. And your nosy mom.

  


  Okay, so are we clear on the pros and cons? Look, the truth is cloud services are great and getting better every day. Yes, there are some dangers and you should still back up your files in a place you, and only you, have access to. Where do you hide your vaping supplies from your wife? That’s probably a good place to store your backup drive.


  If you’re willing to accept the small downside to using cloud services, you’ll reap the many rewards of doing so.


  One of the greatest benefits to me that might be of interest to new Ubuntu users is the ability to walk away from a disastrous install and start fresh without worrying that all your precious memories just disappeared because you followed some joker’s suggestion to type “rm -rf /” at the command line. (Don’t do it! It does filthy things and you’ll hate yourself in the morning).


  By keeping your most important files, photos, music, and downloads backed up, you can cleanly reinstall the distro of your choice and simply download your files from the cloud when you’re ready.


  Not surprisingly, Ubuntu offers an easy way to set up some cloud storage and start using it almost immediately. It’s called Ubuntu One, it’s free, and you’re almost done setting it up – it’s that simple.


  Ubuntu 12.10 comes with Ubuntu One pre-installed and loaded on the left-hand app drawer. Find and click the icon that looks like this:
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  You’ll get this window:
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  Click the button that says “I don’t have an account yet - sign me up.” You’ll go through some typical setup procedures including a Captcha. If you fail the Captcha, double check. You might not be human.


  Ubuntu One will send you a secret code (it’s all very NSA, need-to-know type stuff). Enter that into the registration screen and click Next. You’ll have the option to select which folders you want to sync to The Cloud. I suggest Desktop and Documents at the very least. You can add more at any time. Click Finish, and Ubuntu One will start syncing those folders for you. Depending on how much stuff you have in those folders, it may take a while.


  The next time you click the Ubuntu One icon, you’ll be greeted by name – which is a little creepy – but whatever.
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  From now on, anything you add to the folders you asked Ubuntu One to sync will automagically get uploaded to The Cloud and be available on any other device with access to that account. So, if you started Ubuntu One from your desktop, and then log into Ubuntu One from your laptop, you’ll have access to the files from your desktop. Note that you’re not accessing your desktop, just the files that were copied from there and stored in Ubuntu One’s cloud service. Make a change to one of those files and the changes will be reflected in the file the next time you access it from your desktop (or anywhere else).


  If you have a smartphone, you can search the app store for Ubuntu One and download it. Once you log in with your credentials, you’ll have access to your files on the go.


  Ubuntu One gives you up to 5 gigabytes of free storage, but you can pay for more if you need it. You can store music files as well, but you won’t be able to stream those files to another device unless you upgrade to the Music Streaming package which is $3.99 per month. Upgrading also nets you a total of 20 gigs of storage which you can use for anything you want, not just music. Your collection of Justin Bieber fan-fic erotica is now safe for the ages.


  Can you smell that? That’s what freedom smells like! Now you can mess with your Ubuntu install, play around with settings, dual boot into the latest unstable version, stay up all night, sleep all day, and live life on the edge! You don’t care, you’re a rock star! And all your important files are always available simply by logging into Ubuntu One!


  Play around with Ubuntu One. If you don’t like it, you can disconnect the file syncing and try something else like Dropbox or Google Drive or any number of other services. Most will have a free version that’s pretty good for most casual users.


  My dad would be so proud of you! And just for the record, it was usually him “dealting” it.


  Good luck and happy Ubuntuing!


  Linux Labs - Tomato anyone?


  By Charles McColm, chaslinux@gmail.com.


  Several years ago, I went out and bought a mid-range priced personal router from one of the big box stores. We had used a couple of older models of this brand of routers at work, so I figured they were pretty good quality. But, after less than 6 months, I found the router constantly dropping wireless connections. I tried changing the channel the router was on (Im in an area of heavy wireless router usage), but, regardless of which channel I used, it seemed I found myself resetting the router at least once a day. Running:


  
    sudo iwlist scanning | grep Cell | wc -l
  


  normally shows between 51-85 connections depending on the day and time I run the command.


  Because I work for a computer refurbishing project, I decided to buy a different brand router for our project and give it a shot. The router worked out quite well, it didnt drop wireless connections nearly as much, but sadly it was missing features  DHCP reservations for example. About the same time all this was happening, I heard several members of our local Linux User Group were hacking their own routers. In fact, a regional ISP was offering pre-hacked routers for slightly more than the cost of buying the router in a big box store.


  Our family had decided to switch ISPs anyway, but before I could buy the router myself, I found myself on the receiving end of a Linksys WRT54GL Linux based router (over the holiday season).
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  The stock Linux-based firmware on the WRT54GL isnt bad, but one of our local LUG members, who also happened to be a co-worker, convinced me to take a look at Polarclouds Tomato firmware by showing me the built-in features: pretty traffic graphs (Im a sucker for eye candy), Quality of Service, Wireless Filtering, Access Restrictions, Port Forwarding, Dynamic DNS, and a number of tools.


  At the time, I was planning on running a small server, and the new ISP not only sold static IP addresses at a reasonable price, but also allowed servers to be run. (In our area, the big ISPs discourage home users from running servers). I could have manually set the static IP address on each Linux server in our house (we have a couple with the XBMC machine and the Game/Web server), but I find it easier to keep the machines on DHCP and set the IP reservation on the router. Setting the IP reservation on the router also means other clients behind the router know about the machine/hostname.


  Polarclouds Tomato firmware works only on particular routers. You need to be careful because, even within certain models of routers, some are, and some are not supported. Flashing your routers firmware, of course, voids any warranties. Like flashing a computer, it could brick your router if interrupted or flashed with the incorrect firmware. Be careful and informed. The polarcloud web site http://www.polarcloud.com/tomatolists which routers, models, and the particular version of each model supported. Linksys WRTGS v1 is supported by the tomato firmware as I write this article, but Linksys WRTGS v5 is not supported. You have to be careful, because even slight differences could mean youre left with a doorstop instead of a router.


  Once youve downloaded the correct firmware from Polarclouds website, unzip it. Inside youll generally find several .bin files for different models of router. Be sure to read the readme html file unpacked with the archive for any important information before flashing/upgrading your router. Id already flashed my router long ago, but noticed at the start of the article that my tomato firmware was several versions old. I decided to flash/upgrade it. This is the screen I saw during the upgrade (your screen will be different upgrading from stock router firmware).
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  The initial tomato firmware screen looks something like the screenshot below.
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  The first screen shows the status of the router. Ive modified the screenshot slightly. Careful readers will notice the MLPPP Failed message. The tomato firmware is capable of multi-link PPP which allows you to bond multiple PPP connections. Its also useful for doing some trickery to get around some of the traffic shaping technologies certain providers use. While were subject to traffic shaping, I havent bothered resetting the router for MLPPP because we do so few torrents that we dont tend to feel the traffic shaping much.


  Most of the options on the left hand side of the router expand to reveal further options. Within status you can see the status of your connection to your provider, the DHCP leases youre giving out, as well as different wireless options.


  The Bandwidth screen is where you can see pretty graphs for Real-Time traffic and traffic within the last 24 hours. The Daily, Weekly and Monthly traffic is all expressed numerically, but you can choose to display in gigabytes or megabytes.
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  Take note of the items in red in the bottom right of the screenshot. Any item with an underline is the current option. Clicking an option beside will change the option. Clicking the word Line in the Display option in the bottom right results in the graph displaying as a line rather than a filled-in graph. Along the top we have graph tabs for the various interfaces on the router including a couple of vlan ports.
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  Within the tools section there are a number of tools, a tool to ping a server/system, a tool to trace the route to a system/server, a tool to set wake-on-lan for systems within your network, and a tool to conduct wireless surveys of your area.
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  RSSI (received signal strength indication), the amount of Noise and channel of other routers is helpful, but of course this can also be done (better) in Linux with the iwlist scanning command. Wireless Site Survey doesnt list all of the wireless access points in range. In the example above only 1 router is using channel 6 (interesting since most routers around here are set on channel 6 by default).


  The Basic > Network screen is where you set all your routers basic options: type of WAN/Internet (DHCP, PPPoE, Static, PPTP, L2TP, or disabled), your routers LAN address and DHCP information and that IP range, as well as your routers wireless settings. If you plan on using one of the dynamic DNS services out there, the Basic > DDNS screen is where you set up your router to communicate with whatever DDNS service youre using.
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  Recent tomato firmware had a choice of over 23 service options from a number of providers including 3322, DNS Exit, DNS-O-Matic, DynDNS, DyNS, easyDNS, EditDNS, EveryDNS, eNom, FreeDNS, Namecheap, OpenDNS  to name a few.


  The Basic > Static DHCP screen lets you see who has static DHCP reservations on your network. You can also assign static DHCP reservations on this screen, but its actually more work than you need to do. Its easier to assign the DHCP reservations on the Status > Device List screen where you can click the word static under the devices MAC address. Still, this page is useful because the Status > Device page doesnt show which addresses are static.
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  If youre having trouble with a particular person who keeps trying to log in to your router, or perhaps you let someone have access to your router and they abused it, you can set a wireless filter on the Basic > Wireless Filter screen. You can also permit only certain wireless connections by specifying Permit only the following clientsalong with their MAC addresses.


  The Advanced menu has a number of sub-menus including Conntrack/Netfilter options, DNS options, Firewall options, MAC address options (useful if you need to clone your PCs MAC address when youre trying to connect to a modem youve used with a PC), routing, wait time, and a couple of miscellaneous options. There is a lot that can be finely tweaked within the advanced menus, things like putting the router into Afterburner mode (also known as 125 High Speed Mode, basically a mode thats suppose to be 30-40% faster than 802.11g), allowing your router to respond to pings (I turn it off), and setting TCP and UDP timeout times.


  Its within the Port Forwarding > BASIC menu that I punched the holes necessary for the outside world to see my servers services. For the game server, I looked to the readme and game configuration files for which ports to open. Search engines are your friend for common ports if you dont already know them.
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  Also within the Port Forwarding menu are DMZ options, Triggered Port Forwarding options, and UPnP/Nat-PMP options.


  Tomato can do Quality of Service (QoS). The QoS menu consists of basic settings where you can assign inbound and outbound traffic percentages to terms Highest, High, Medium, Low, Lowest, then Class A-E. The QoS > Classification screen is where you set which machines on your network get those Highest, High, Medium, Low and Lowest priorities. You can also view a pie graph or details of your QoS if you have it set and configured.
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  In our house, my wifes PC had the highest priority, followed by DNS traffic between 0 and 2KB, then WWW traffic between 0 and 512KB.


  The Access Restriction menu option has no sub-options. It allows you to set rules like Turn off the routers wireless between 11pm and 5am (useful if you have teenagers who like to surf all night instead of sleep).


  If you install Tomato on a router, the Administration > Admin Access menu will be one of the places youll want to visit. On the admin access screen, you set options like the routers password, whether you want the router to allow SSH (also on which port and keys), Web administration options, and (yikes!) Telnet options.


  I dont want to sound too much like a broken record by listing all the menu options below the Administration menu, so Ill point out the few that I actually use: Admin > Configuration is where you back up your routers configuration to and from your PC. Admin > Upgrade is where you upgrade your Tomato routers firmware (or revert it back if youve backed up the old firmware). The CIFS Client menu option is intriguing. When I looked into it further, I discovered it seems to just be used to mount a CIFS (Windows) share for bandwidth monitoring purposes. About, Shutdown, Reboot, and Logout are obvious, so I wont cover them here.


  Ive actually only barely scratched the surface of the Tomato firmware options. I didnt cover a lot because there are literally hundreds of options in the Tomato firmware. If youve ever been dissatisfied with a router, give the Tomato project a look, check out the compatible routers (making sure to pay attention not just to models but also version numbers), and I think youll be satisfied with the amount of options available. Also worth checking out is the DD-WRT project which does similar things but tends to be more modular.


  Important Links:


  
    	Tomato Firmware page: http://www.polarcloud.com/tomato


    	Wikibooks Tomato Firmware reference: http://en.wikibooks.org/wiki/Tomato_Firmware/Menu_Reference


    	DD-WRT: http://www.dd-wrt.ca/site/index

  

  


  
    Charles McColm is the project manager of a not-for-profit computer reuse project. When not building PCs, removing malware, encouraging people to use Linux, and hosting local Ubuntu hours. Charles runs a free Mana World MMORPG server at http://www.auldsbel.org/, and bakes bread from recipes on Youtube.
  


  My Story


  by BlackAdder


  The first time I ever heard about Linux was five years ago, I think. It was in our town library, where they were installing Ubuntu on a PC. That way, everybody willing to learn this new OS could have a go.


  I even remember multiple CDs lying on the counter waiting for somebody to take them home. And I did. I think it was Feisty Fawn or Gutsy Gibbon.


  The first time I gave it a try, I was amazed and confused at the same time.


  Remember, I'm coming from a Windows-only environment. Didn't know the first thing about open source and what it meant or stood for. The only thing I knew was that it was free and not some pirated copy.


  I'll never forget my first reaction after having taken my first looks at the screen: "what the ......?"


  This was something I didn't expect. That feeling didn't leave me for a long time. I always thought about Ubuntu in those days as that other OS.


  But it was knowledge that I was missing. Knowledge of what Ubuntu stood for. (And still does.)


  After playing around with it for some time, I forgot about Ubuntu for a while.


  It was when I attended night-school, for a bachelors in IT, that I was again put in contact with Ubuntu. But this time, with much more background to it.


  This was around the time that Jaunty Jackalope hit the streets. It was there, at school, that I learned much more about the OS itself, about its rich features, the way it works, and so on.


  From that time on, I've been an enthusiastic user of Ubuntu. Whether it's the desktop version or the server, I'm liking it and using it.


  At work, there's a mix of Windows and Apple workstations, but I'm glad to see the introduction of Linux. Its on the server side, but it's a start.


  When I look back at our town library now, I'm more than happy to see that all of the workstations, public and private, have switched to a Linux OS. Kubuntu, to be precise.


  So that's my little story about how I came into contact with Ubuntu. It's been some years now, and most of the hardware at home is running Ubuntu and doing just fine. Most people I know these days, consider Linux as their weapon of choice, when it comes to installing a fresh OS on the hardware. I especially like the fact that it doesn't matter whether it's old or new hardware. Just install the OS and run it. (This is a great argument to get people using Ubuntu.)


  My Opinion


  by Ed Hewitt


  Earlier this month, Canonical held itsfirst press event to unveil its phone operating system, Ubuntu for Phone. This is a product many have speculated would happen after the launch of Unity, providing a touch interface, as well as Canonical bringing Ubuntu to Android devices. While Ubuntu for Android allows the Ubuntu desktop to run on a smartphone device via a computer dock, Ubuntu for Phone is a complete smartphone OS to challenge iOS and Android. I believe Ubuntu for Phone is dead on arrival; it will fail.


  One of the first challenges Canonical needs to overcome is the hardware partners. Canonical management have claimed that they expect Ubuntu smartphones in 2014; however, until I see a device, Im not holding my breath. The smartphone market is incredibly competitive. Many of the large manufacturers are struggling to keep up. For example, HTC has been reporting losses quarter on quarter. Hardware manufacturers will find it hard to bet on an unproven platform. Samsung, Sony, and Motorola are having great success with Android. HTC is already playing across two platforms, and Nokia has dedicated its future to Windows Phone. This leaves Canonical with the smaller manufacturers such as Huawei and LG. Providing they find a hardware partner, will the device itself be any good? Poor hardware and build quality will affect the success of Ubuntu on phones. We have seen Samsung produce poor Windows Phone devices  just to have a device on that platform. We could see Canonicals hardware partners doing a similar thing.


  The next hurdle Canonical has to get over is carrier support  providing it has a device to sell them. Carriers can make or break the success of a device. They are the ones who will buy the device from the hardware manufacturer and sell it to their customers. If they dont believe it will sell, they will not be interested. The most famous example of this is Palms WebOS. Carriers killed WebOS. After HP ended development of WebOS, Jon Rubinstein (CEO of Palm) was interviewed by Josh Topolsky of The Verge. Palms WebOS devices were picked up by Sprint and Verizon in the US, since neither carrier had the iPhone at the time. Both were prepared to market and sell the device to their customers; however, Verizon heavily marketed the new Motorola Droid, and Sprint did not have a large enough customer base to sell the Palm Pre. Although many journalists in the industry praised both the hardware and software, carrier support was lacking, and subsequently Palm, and eventually HP, struggled to generate interest. This could happen to Canonical.


  The software could be killer, the hardware could be excellent; but if carriers are not prepared to sell and market a device, Ubuntu for Phones is not going anywhere.


  Canonical could do what Google is doing, by selling its Nexus devices unlocked, off-contract from its website. This will avoid the carriers. However, I do not believe that this will work. It still requires heavy marketing to attract attention, it needs to be priced competitively, and Canonical may not have the infrastructure in place to sell and ship a device. They need the carrier support  mainly to hit the mass market  and the ability to sell the device to the average Joe.


  The final roadblock that Canonical will hit is app support  this is the Achilles heel for all computing platforms. You may have a brilliant platform, but, if you dont have the apps people want, you are a dead platform. The reason iOS and Android are so successful is because they have the killer apps which customers want. They want to be able to access Facebook, listen to music on Spotify, watch films on Netflix, use navigation with Google Maps, play a quick game of Angry Birds. Both Blackberry and Microsoft have had this issue; they are struggling to get the developers on board to produce apps for their platforms, and they both have a reasonably sized user bases. Many developers have already said they are not interested in producing apps for Blackberry and Windows Phone. Recently, Google has said it will be supporting only Android and iOS. Canonical is bringing a 5th platform for developers to make apps for, and I cant see them doing it, and this is discounting all the other minor smartphone OSs out there. There are too many platforms trying to build an app ecosphere. If they are not willing to support Microsoft and RIM, why would they support Canonical?


  Providing Canonical finds a hardware partner, gains the carriers support, and has a wealth of popularapplications; there is still the competition to deal with. As of December 2012, Android and iOS make up about 85% of the worlds smartphones. They will be the dominant platforms for the foreseeable future. However, there is also third place to battle for, but that is already locked down between Windows Phone and Blackberry. It will be an interesting 2013 for these two. Windows Phone 8 will be seen on more devices, and RIM will be releasing Blackberry 10. Fourth and fifth places are currently held by Symbian and Bada and its highly unlikely they will move from those spots. Plus, there are the minor smartphone platforms  which is where Ubuntu for Phones will likely sit. Heres the list of the major minor platforms; there are a few more:


  
    	Firefox OS


    	openWebOS


    	Maemo


    	MeeGo


    	Tizen


    	Jolla

  


  In a market where Palm has gone, Blackberry has fallen from greatness and is struggling to survive, and the might of Microsoft is unable to put a dent in Google and Apple, how does Canonical think it can survive? They have had minor successes in the desktop and server space, but I think this time Canonical has bitten off more than it can chew.


  Review

  Sony NSZ-GS7 Google TV Box


  by Ronnie Tucker


  I was quite apprehensive about buying this Internet media player as there were so many negative reviews about it, but I decided to take a leap of faith (in Google) and buy it anyway. Im glad I did!
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  Whats In The Box


  The box is small! I expected to receive a box about the size of a DVD player, but the cardboard box is about 8 x 6 x 4. Inside is the Sony box itself, the remote, batteries (for said remote), power cable, and an IR blaster (more on that later).


  Setting Up


  Hooking the box up is easy enough. You plug in the power cable and (not supplied) HDMI cable. Plug the power cable into the wall socket and the HDMI cable into your TV.
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  Im using the box by itself, but you can hook your cable/satellite box into the Sony box. This lets the Sony box control the displaying of your cable/satellite box allowing you to do fancy things like picture-in-picture and such-like.


  Configuration


  When the box is first turned on, it will pair itself with the remote as the remote control is bluetooth. No need to point the remote directly at a sensor. There is none. Using bluetooth means you dont even need to point the remote, just press the buttons and itll be detected as long as youre within range of the box.


  You now get a quick introduction on how to use the remote control. This is a very special remote (more on it later), but suffice it to say that it has buttons and touch-pad on one side, and a full QWERTY keyboard on the reverse.


  Now were on to setting up the box itself. You sign in with your Google account, set the language, time zone, connection to the internet (wired, or wireless), and your screen size. You then configure the IR blaster.


  IR Blaster


  The IR blaster is a little widget that you get with the box  which you dont have to use if you dont want to, but it lets you control another box with the Sony remote.
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  Initially, I was using it with my TV, or so I thought. I had the IR blaster pointing at my TVs remote sensor. On telling the Sony box that my TV is a Samsung (and model number), I can now switch the TV off/on using the Sony remote. Nifty! It was only when I noticed the IR remote covered up that I realised the Sony box is actually controlling the TV via the HDMI cable. More on that in a second.


  Update


  No sooner had I completed the setup, and searched feverishly for Netflix (which I couldnt find), I was presented with a pop-up telling me a system update was available. Carry on!


  After the update, I now had the Netflix application. Phew! I also had Google Play, Chrome (browser), Live TV (only of use if youre connecting a TV/satellite box through the Sony), Media Player, Photos (viewer), [Google] Play Movies, [Google] Search, Settings, Socialife (Twitter and Facebook only it seems), Sony Entertainment, Twitter, and a couple of other items.


  I installed [Google] Play Music, to try streaming audio (which worked fine), and Plex which will let me stream media from my desktop PC to the Sony box.


  The Remote


  As I hinted at earlier, the remote is very special and took a lot of criticism in reviews, but I love it! On one side you have several on/off buttons (for TV/amp/other) and some selection buttons to control a PVR/TV. Just above center you have a D-pad with selection button in the center. Either side of the D-pad are buttons to do picture-in-picture, back, home, and menu. Taking up about half of the remote is the touch-pad, which is clickable. Touching this brings up a mouse pointer on screen. Below the touch-pad are function, play, pause, and info buttons. Lastly, there are some coloured buttons.


  Flipping the remote over, you have a full QWERTY keyboard! Pressing function, then search, will enable a backlight to the keyboard, handy for those late night browsing sessions.


  On the right side of the remote are volume, mute, and channel buttons. The remote is also motion sensitive for controlling games.
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  Video


  I havent tried purchasing/renting videos via Play/Sony, but certainly YouTube and Netflix worked flawlessly and the picture quality was excellent.


  Audio


  Again, havent tried using Play/Sony stores, but several tracks on my Google Play/Music account worked fine after installing the Google Music app.


  Streaming Media


  Most of my media is on my desktop PC. Thankfully, getting this playing on the Sony box was easy enough  after installing Plex (paid app, but is less than 1) on the Sony box and on my desktop PC. Plex on the desktop is a media server which will, after initial set up, run through and catalogue all the media in the folders youve given it. Plex will then sit and wait for connections before serving up media.


  Installing Plex on the desktop either means downloading, and installing, the .deb file from the Plex site (http://www.plexapp.com/), or adding the relevant repo. You then install the Plex media player on the Sony box. On the Sony, you click Plex; it will search for a Plex server, and then let you play your media. Simple as that!
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  Be patient, as Plex can take a while to catalogue your media as it will also fetch metadata and relevant images.
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  Plex can play/stream pretty much any audio/video file you throw at it.


  Additions


  Recently a Chrome extension was released called Chromemote (http://www.chromemote.com/). What this does is let you control your Google TV box from within Chrome. For example: on my desktop PC, I can click the Chromemote icon in Chrome, switch on my Google TV box, switch on my TV, and then have full control over my Google TV box without even picking up my remote control! I must say, its pretty awesome.


  Not only that, but it gives you the option to fling almost anything to your box. I could start a YouTube video, then think hey, this is pretty cool and fling it to my box to watch on the big screen.
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  If you have a guest/partner and want to show them something, you can fling a web page to Chrome on your Google TV box.


  Conclusion


  Ive said many good things about the Sony Google TV box; whats the down side? Apps. There arent that many apps available for the Sony box. While it does use Google Play as its source, youre limited to only apps that are known to work on Google TV. However, as I write this review, it is possible to side-load apps by loading the APK file. There are some good apps in Play like AirDroid, Evernote, and the like.


  Moving between menus and items feels a bit sluggish, but thats nothing major. It could be because the box is using Android 3.2 and not the buttery Jelly Bean.


  Even with those negative points, Im a happy chappy. It does everything I needed it to do, and more. Previously, I had to use my Xbox for Netflix and TV, and my Acer Revo for streaming media. Now I have everything in one package.


  Now, if we could have a Jelly Bean update... thatd be the icing on the cake!


  Rating: 4/5


  Letters


  Home Server


  Would it be possible for someone out there to write an article(s) on setting up a home server? It should be running Ubuntu (of course), machines will do a network boot, data would be available on the server and the Internet will be too. Something that would be cheap, feasible and useful.


  Danish Lala

  


  Ubuntu Is Too Hot!


  My Dell Vostro 1550 laptop dual boots with Ubuntu 12.04 LTS and Windows 7 running side by side. I am a huge fan of Ubuntu, who tries to get things done in Ubuntu alone, and I always try to convince other people to switch to Ubuntu. But I am afraid of the overheating problem in Ubuntu systems.


  When I am working in Ubuntu, my laptop overheats quickly and seldom cools down to normal state, and the processor fans run almost all the time to cool down the processor. Besides the noise from the fan, the battery drains quickly due to the same reason. When compared to PC


  running in Windows 7, the battery drains out quickly when it runs in Ubuntu.


  I wish someone could write an article on solutions for this problem. Which may help me in making more Ubuntu fans


  Saravanan M

  


  Scanning


  Gord, regarding your checklist for checking new distros. You could add scanning. This was the one problem that prevented me from ditching Windows until Ubuntu 11.04 came along and solved my problem.


  Michael Davies

  


  Chinese in LibreOffice


  A few days ago a friend asked about writing Japanese in LibreOffice. I pointed him to to the article in FCM#43 (Command & Conquer by Lucas Westermann). He came back saying that it didn't work. Testing, I found that all I could get was a row of rectangles.


  Like the author of this piece I found:


  
    Although Japanese entry worked perfectly on everything else, LO refused to show any Japanese characters (just empty/blank boxes) even though I had set the default Asian language to Japanese and checked the Asian languages option.
  


  The author had a solution:


  
    Turns out theres another set of options under Tools > Options > LibreOffice Writer > Basic Fonts (Asian). Switching the font to Droid Sans Japanese solved the problem.
  


  Although I haven't tried it (yet) the same method will probably work for Chinese and Korean (using Pinyin and ?Hangul).


  Brian


  ﻿Q&A 69


  Compiled by Gord Campbell


  
    	Running LibreOffice Writer under Ubuntu 12.04 Powerpc on an eMac G-4. I inserted a picture from file, then tried to export it to a PDF. Total fail.


    	Install cups-pdf. From the File menu in Writer, select "print," and choose "pdf" as the printer. When you click on "print," a file will be created in the PDF folder in /home.

  


  
    	Can I use Kindle for PC under Wine?


    	Yes! See post 3 of this thread: http://ubuntuforums.org/showthread.php?t=1913348
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    	If I am using two USB ports, one for the the OS and the other for data, how can I determine which is which?


    	
      Open a terminal and enter this command:


      
        sudo fdisk -l
      
In the first line for each device, it shows the size, such as:


      
        Disk /dev/sdc: 8413 MB, 8413773824 bytes
      
The OS will typically be a lower device code, such as sda.
    

  


  
    	I plan to put a larger hard drive into my dual-boot laptop. What do you suggest as a partition setup?


    	
      Make sure you understand whether your laptop supports IDE or SATA before you make your purchase.

      It's much easier if you install Windows first on a new hard drive.

      

      I'm not sure if Windows 8 likes to have a boot partition? If so, I would use these partitions:


      
        	boot, 100 MB (or whatever Windows wants)


        	Windows, 120 GB


        	an Extended partition for the rest of the drive. Within it:


        	
          
            	/ (that's pronounced "root") of 30 GB


            	swap, two times the size of memory


            	/home, the remaining space.

          

        

      
The root partition is a lot larger than it needs to be, but it's an enormous disaster if it fills up, and I have heard of runaway system logs that grab space quite quickly. Having a separate /home partition means you can install a new version without disturbing your data.

      

      I also suggest buying a USB enclosure and installing the old drive there.
    

  


  
    	Is there any way to install the ATI drivers for the 4670 on Ubuntu 12.10? 12.04 picks it up and installs them for me right off the bat.


    	
      (Thanks to Temujin in the Ubuntu Forums) AMD dropped support for that card in newer versions of fglrx/Catalyst. Your options:


      
        	Use the open-source driver


        	Use *buntu 12.04/LTS


        	Downgrade your Xserver so the older fglrx/Catalyst legacy driver will work on 12.10

      

    

  


  
    	In Kubuntu, is there a hotkey to lock the screen? Can I set it to lock after a few minutes of inactivity?


    	(Thanks to amingv in the Ubuntu Forums) The default key combination to lock the screen is Ctrl+Alt+L. The other question is a screensaver setting.

  


  
    	My display does a little "flicker" every time there is movement on screen. I use Xubuntu 12.10, and have an Intel Corp 3rd gen core processor graphics controller (rev 09), aka 4000HD. It appears to be an XFCE issue.


    	"Sync to VBlank support to the Xfwm compositor" seems to help. See: http://www.webupd8.org/2012/10/xfce-sync-to-vblank-support-for-xfwm.html

  


  
    	There was a ppa set up for Cinnamon applets and themes, but now it has been removed. When I run Update Manager, I get an error message. How can I remove the ppa from my sources?


    	(Thanks to Askubuntu) The error message includes the full name of the ppa. Use this command:

    div class="terminal"> sudo add-apt-repository --remove ppa:whatever/ppa

  


  
    	(Thanks to John O'Flynn.) I use LastPass (an add-on for Firefox) and it repeatedly sends me the message "An error occurred while attempting to contact the server. Please check your internet connection."


    	The problem turned out to be a tangled series of phone cords between the phone jack and the modem. When the modem was plugged directly into the jack, everything worked perfectly.

  


  
    	In Windows I always choose to do a long/slow format so Windows can mark bad sectors on the drive. I added a data drive and formatted it, half as NTFS for my Win7 multi-boot and the other half as EXT4, for Lubuntu. The format only took 2 seconds on the EXT4 section of the drive, so it obviously didn't check for bad sectors.


    	(Thanks to 3rdalbum in the Ubuntu Forums) Modern hard disks are capable of determining bad blocks on their own. If they go to write data to a block and find that the block is bad, they automatically flag it and write the data to a better block. All disks have a hundred spare blocks for this purpose. If you're worried about bad blocks on a disk, check out its SMART statistics; Disk Utility can read the SMART information from a hard disk and find out how many bad blocks have been flagged. If it starts getting up toward the number of spare blocks, you need to copy your data off the disk and drop the disk into the nearest rubbish bin.

  


  
    	Is there a GUI method of setting up a shared folder in Xubuntu?


    	Yes, install system-config-samba as well as samba. "Samba" appears in System Settings.

  


  
    	In Ubuntu Server 12.04, with a static IP address, I can't ping google.com?


    	
      (Thanks to cheesemill in the Ubuntu Forums) From 12.04 onwards you shouldn't edit resolv.conf directly, as it gets rewritten by the system. Instead, you should add the following line to your /etc/network/interfaces file:


      
        dns-nameservers 192.168.1.1
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  Review: Snapshot


  by Jennifer Roger


  Snapshot is a single player puzzle/platformer by Retro Affect.The story follows the adventures of an adorable robot named Pic. Pic is all alone, and armed with just a camera - a magical camera that has the ability to not only take pictures, but delete them as well. However, you are limited to just three photos, which introduces the challenge of using your snapshots wisely.


  Taking these real-time photographs is the heart of Snapshot, allowing you to solve each level by placing and rotating cubes to collect items and reach your goal. The environments are quite dynamic and Pic will also be called upon to interact with various creatures and objects to clear a stage. For example, you can activate levers to free blocks from no picture zones, or use flying elephants as a springboard onto a high ledge.


  [image: ]


  Snapshot is mainly a puzzle game, but there are also solid platforming elements. As with other platformers, there are common dangers like fireballs and massive pits of spikes. Retro Affect was able to find the right balance between puzzle and platformer that is not too easy nor brutally challenging.


  Although each level can be cleared fairly quickly, there is plenty incentive to replay levels to fully complete the stage. Each level has secret items that can be collected and added to your gallery. Just snap a photo of the object and it will automatically be added to your collection. Most of the items arent too hard to find, but it can be easy to overlook them if youre just trying to beat the level. In addition to collecting all of the stars, the time trial allows you to beat your best time. All of this adds tremendous replay value in addition to the hundreds of levels in the game.


  [image: ]


  Snapshots controls are simple and easy to learn - the keyboard controls navigation while the mouse operates the camera. The mouse buttons are for taking and deleting pictures, while moving the mouse around gives you a better look at your surroundings. The actual feel of the mechanics took a bit of getting used to as the controls have a tendency to be overly responsive. On one hand, its nice that Pic can jump so high with a single click, but he can also be difficult to control when the situation requires a little finesse.


  Aesthetically, Snapshot evokes memories of Rayman and Braid. All three games have a distinct artistic style, and the environments are colorful and vibrant. Although there are only subtle changes between the four environments, the visuals are gorgeous to look at. The soundtrack is equally beautiful and compliments the gameplay nicely.


  [image: ]


  Snapshot proves to be a clever puzzle game with just the right amount of challenge. Its loads of fun and there are plenty of secrets, collectables, and, with over 100 levels, youll have lots to keep you coming back for more. If you werent able to snag the latest Humble Bundle, Snapshot is available for download at retroaffect.com and is redeemable on Steam. The DRM-free, cross platform gem will set you back $9.99 for the game only, but you can also get the game and soundtrack for $12.99.


  Pros: Fun concept, great replay value, balanced gameplay


  Cons: Touchy controls


  Score: 4.5/5


  
    BIO: Jennifer is a fine arts student from the Chicagoland area. You can follow @missjendie on Twitter or visit her blog at missjendie.com.
  


  Linux Certified


  by Richard Philip Witt


  Chapter 2 of my LPIC-1 study book deals with managing software. More specifically, with package management, managing shared libraries, and managing processes. My coverage here of chapter 2 content will be limited to a brief treatment of package management, as I amalready after only one month of studying, lagging well behind. Hofstadter's Law comes to mind as I write. The law states, and please excuse my paraphrasing, that everything takes longer than expected, even when you account for Hofstadter's Law.


  For Exam 101 of LPIC-1, you must be familiar with both RedHat and Debian package management, as well as knowing how to convert between the two. Ubuntu, as it's Debian-based, usesdpkg, the apt command suite or Synaptic. I shan't bore you with the details, but essentially one needs to learn many of the common package management command options by heart. For example, the difference betweendpkg -r (--remove)anddpkg -p (--purge). dpkg -premoves both package and configuration files while dpkg -rremoves the package files but leaves the configuration files intact.


  Learning for Exam 101


  I cannot stress enough how specific one's knowledge must be for this exam, and this is responsible for my slow progress, in part at least. I don't use Ubuntu, or any distribution, in my daily work, where I could practice and apply my Linux knowledge. Furthermore, my personal needs don't require me to address many of the higher-level functions needed for Exam 101. Hence, I have produced sets of flashcards and learn by rote. The flashcards are effective, but they take some time to produce. Yet repeatedly transferring information from text books to flashcards is mind-numbing at best.


  There aretest questions at the end of the book chapters, but only around 25 questions a chapter, insufficient to point out knowledge gaps and foster learning.


  My style of learning throws up a few oddities. A case in point, I've learned that the main two userconfiguration files are located at ~/.bashrcand ~/.profile(globalconfiguration files are located elsewhere). I don't know how to interpret the contents of the files nor what to do with them, but I do know where they're located. Having said that, one general feeling has stuck with me, which is a sense of awe at the complexity of this operating system: whatever you may want to alter, it can be done.


  Some commands, however, have proven to be very useful. For example, coding errors often refer to a line number. A simple cat -n file.txt > file_lines.txtwill produce file_lines.txtwith line numbers (blank lines also numbered). Alternatively, with a short piece of code, one could print directly to the screen with:


  
    cat -n file.txt.
  


  I've also found some pieces of knowledge that have been conceptually very helpful, nice to know. For instance, have you ever wondered why commands in man pages are numbered?In the top left-hand corner of all man pages, you can see the command to which the man page refers (e.g. passwd) and a number (e.g. passwd[1]). At the bottom of the man page, you can sometimes see the command together with more numbers (e.g. passwd[5]). This number refers to the man section in which the command is to be found. passwd[1]is a shell command and passwd[5]is a file format: sections 1 and 5 of the man page categorization are 'bash and shell commands' and 'file formats', respectively. By default, the man command takes the lowest number categorisation. If you want to access the man page forpasswdthat relates to file formats, type:


  
    man 5 passwd.
  


  In short, I've still got a ways to go, but I'm starting to integrate this knowledge into my daily Ubuntu usage. Hopefully, one day everything will start to congeal. I need to find some more resources though.


  FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles – and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org.


  We are always looking out for new articles to include in Full Circle. For help and advice, please see the Official Full Circle Style Guide:http://url.fullcirclemagazine.org/75d471


  
    	Send your comments or Linux experiences to: letters@fullcirclemagazine.org


    	Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org


    	Questions for Q&A should go to: questions@fullcirclemagazine.org


    	Desktop screens should be emailed to: misc@fullcirclemagazine.org


    	... or you can visit our forum via:www.fullcirclemagazine.org

  


  Full Circle Team:


  
    	Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org


    	Ebook - Jens Leineweber - mobile@fullcirclemagazine.org


    	Webmaster - Rob Kerfia - admin@fullcirclemagazine.org


    	Podcast - Les Pounder & Co. - podcast@fullcirclemagazine.org

  


  Editing & Proofreading:


  
    	Mike Kennedy


    	Lucas Westermann


    	Gord Campbell


    	Robert Orsino


    	Josh Hertel


    	Bert Jerred

  


  Our thanks go out to Canonical, the many translation teams around the world, and to Thorsten Wilms for the current Full Circle logo.

  


  Getting Full Circle Magazine:


  
    	EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org


    	Google Currents- Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app), and you'll be able to add issues 55+. Or, you can click the links on the FCM download pages


    	Ubuntu Software Centre- You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full circle', choose an issue, and click the download button


    	Issuu- You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.


    	Ubuntu One- You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button which is available on issues 51+.

  

OEBPS/Images/Blender02.png





OEBPS/Images/LinuxLabs08.png
568,41 kbit/a (695,00 K/a) >

WAN ) WL ()

417480 xie/a (521,85 KB/

278320 wse/a (347,50 KB/n)

155160 Kie/a (17355 KB/

b0

vian

viant






OEBPS/Images/Ubuntu2Gnome04.png
@® anome

@ cNoMEClassic
@ GNOME Classic (No effects)

@ ubuntu

@ ubuntu2o





OEBPS/Images/SnapshotGame00.png





OEBPS/Images/Inkscape02.png






OEBPS/Images/SonyNSZ06.png





OEBPS/Images/LinuxLabs07.png
i






OEBPS/Images/Blender01.png





OEBPS/Images/Inkscape01.png





OEBPS/Images/LinuxLabs06.png
Port Forwarding

On Proto SrcAddress ExtPorts  IntPort IntAddress  Description .
on Boin 8901 801 10002 Auldsbel Game Server x
on Boin 6122 5122 10002 Auldsbel Game Server
on Boin s122 5122 10002 Auldsbel Game Server
on TCP. 0 80 10002 ‘Auldsbel Web Server
E

s

« Src Address (optiona) - Forward ony i fom tis address Ex 1234 "1234-2345" 1 2302¢"
 ExtPorts - The pors 0 be forwarded, 3s seen fom e WA Ex 2345, 200.300" 200-300 400"

« IntPort (optona) - The destination portnside the LAN I diank, the destinaton port s the same as £xt Fors Only one port per entry
s supported when forwarding fo a dfferert nteral port
« Int Address - Th destination address insids the LAN.





OEBPS/Images/Ubuntu2Gnome03.png





OEBPS/Images/Inkscape05.png
SLayers (ShiftsCrrlel) @

® @ Frame

* 8 Tex

% @ Content
%@ Speeder
%@  Rngs
® @ Towers

* =¥ ¢

Blendmode: [Normal &

Opacity, =]

4 &

1000 [







OEBPS/Images/Inkscape00.png
% 2| -shueele muttiply < |





OEBPS/Images/SonyNSZ00.png
- #

wy brary St

=+

Cramnels ot Wiy

e shred s O o .

Qe

oueue

Recommendatons






OEBPS/Images/LibreOffice06.png
2.1abeing fieds.
3. Grouping
4.50rt options
5.Choose layout
& Create report

‘Which filds do you want to have in your roport?

Toblesor quesies
[Quey: AbFiids

avaiablo fods

Binary feds cannot be dispayed in the report

ext > Enish





OEBPS/Images/Ubuntu2Gnome02.png
Have e manger handie th desktop

ShelEstensions
vindows

Compuerconvisbleondeskiop
Homeiconvibleondskeop

Networkseves convisbie onthedeskop. o

Tashiconvible on deskton

Showmounted oumesonthe deskton o





OEBPS/Images/Blender04.png





OEBPS/Images/LinuxLabs05.png





OEBPS/Images/Inkscape06.png
LA AV

Normal Multiply Screen

L AV

Darken Lighten





OEBPS/Images/SonyNSZ01.png
Fing +Jan21, 2011 The ey

Movies S
e RS
Kids Movies FE T e (S
Video Channels

Music Channels
Photo Channels

Queue
Shared Sections






OEBPS/Images/LibreOffice04.png
e, o

e e ks tame i

e s s oo =






OEBPS/Images/Blender03.png





OEBPS/Images/Inkscape07.png
Addiiayer

Layer name: |Layer 2|

Position: | Above current






OEBPS/Images/LinuxLabs04.png
Static DHCP

MAC Address
00:26:82:8C:93:08
00:13:72:DA:AF:CO
00:24:1D:2B:2B:58
00:0B:82:2E:A4:BC
5C: x17.7C7E
00:00:00:00:00:00

1P Address
10.0.0.15
10.0.0.2
10.0.0.10
10.0.0.127
10.0.05
10.0.0.3

Leo-PC
auldsbel
eomie
talkit
viper





OEBPS/Images/LibreOffice05.png
o you want to add grouping levels?

1.k ecton
2.Labeng felds
450t aptons
5 Choose ayous
& creterepor

)

[

Fields Groupings

T — Type
e
Publshed

Note: The dummy text wil be eplaced by data from the database when the
report i created.

SBack | HNet> Ji






OEBPS/Images/Ubuntu2Gnome01.png
_

e overview [Twesks | Admins Janitor X %

A rons K misceineous 1 sound i e
B Lonsetins

W ostiopions (5 window

L Y— —





OEBPS/Images/LibreOffice03.png
1.Field soection
2.1abeing fids.
3. Grouping

£
5.Choose layout
& Create report

‘According to which fiolds do you want to sort the data?

Sortby.

o 4| © Ascending

Descending
Then by,
(T o O Ascanding
T O pecending
Then by.
+) O Ascending
" pesgending

© Ascending.





OEBPS/Images/SonyNSZ02.png





OEBPS/Images/TheNewGuy02.png





OEBPS/Images/TheNewGuy01.png





OEBPS/Images/Inkscape08.png
Layers (SHifEPCERl = =[x
[SLayers (shiftsCirisl) @ ®
8% snowman
8 Ha
8 ams
Head
Body
8 Background

B
»
-
®
»
@

Blendmode: [Normal ¢

Opacity: 1000 [¢






OEBPS/Images/Blender06.png





OEBPS/Images/LinuxLabs03.png





OEBPS/Images/Ubuntu2Gnome00.png
ubuntu1204

leroux





OEBPS/Images/LinuxLabs02.png
oynancons 2

onos-omme -

B






OEBPS/Images/Inkscape09.png
1
Some rghts reserved GZOACTEY





OEBPS/Images/LibreOffice02.png
1.Fild slecton
2.1abeing fids.
3. Grouping
4.50rt options
5.Choose layout

. Creste report}

Docida how you want to proceed
Tite of report

[Fesyryod

What kind o report do you want o create?
Static report

© ynamic report
How do you want 1o proceed after creating the report?

Moy report ayout
© Craste report now.






OEBPS/Images/SnapshotGame03.png





OEBPS/Images/TheNewGuy00.png
one

@t
O

s syeroters

Ldonthaven sccont e signme .

s widow and s p ter






OEBPS/Images/Questions&Answers00.png





OEBPS/Images/Blender05.png
o000 +

- GHE @5

e
@
=

—vosm -





OEBPS/Images/SonyNSZ03.png
H
&






OEBPS/Images/SnapshotGame02.png





OEBPS/Images/LibreOffice00.png
Steps How do you want your report to look?

.t st e (TT——
2.Labeling fields. Oetaut .} Bubbles.
E— =5
3.Grouping Outline - Compact Controling
4,50t options outine - cieqans oetost |
e ot SR
T Okine e Poances
b=y Frtr e
e et o e otuth company Logo
iine. ey Compect e
Duies D St i
o e et e
Guine i e
et Tho dummy et il

repiaced by data rom the database.
[ hentercen's crmes”

.| [ <sock [ Bot> | [ En | [ canca |






OEBPS/Images/Blender00.png





OEBPS/Images/LibreOffice01.png
Steps

1.Fild secton

3. Grouping
4.50rt options

5.Choose layout
6. creste report

How do you want to label

Fiold

e

Label
eda Type
frite

Pubizhed

ol

Enish






OEBPS/Images/SonyNSZ04.png





OEBPS/Images/Inkscape04.png
Slayers (Shift+Ctri+l) @ ®

8 < Layer 1
8 b Layer13
v Layer1.2

a
@ Layer1.2.1
a Layer 1.1

= ¢ &

Blend mode: | Normal <

Opacity, ==("[100.0






OEBPS/Images/LinuxLabs01.png
g |
1Eg C
feisy





OEBPS/Images/LinuxLabs09.png
Tomato/MLPPP

118mp2

-~ 0:24
Plasa vat e it s poases  asnad.
Warmog: 03t U wser ot





OEBPS/Images/SnapshotGame01.png





OEBPS/Images/Inkscape03.png
Layers (ShiFE+Cerl =" 'E
Slayers (Shift+Ctri+l) & &

& -
Blend mode: | Normal
Opacity: ====={_1][100.0






OEBPS/Images/SonyNSZ05.png





OEBPS/Images/LinuxLabs00.png





